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Information in this publication is subject to change without prior notice. GAMMA Medizinisch-wis-
senschaftliche Fortbildungs-GmbH makes no warranty of any kind and reserves the express right to
change this documentation without notification to any other party. 

Despite thorough validation and verification of the product to the highest applicable standards, GAMMA
Medizinisch-wissenschaftliche Fortbildungs-GmbH cannot entirely rule out system malfunction or user
error that could lead to the calculation of incorrect evaluations. Any information provided by the software
must therefore be subjected to a plausibility check by the dental professional and must not be the sole
basis for conducting diagnostic or therapeutic decisions. Final responsibility for the patient always rests
with the attending physician. GAMMA Medizinisch-wissenschaftliche Fortbildungs-GmbH accepts no li-
ability.

Guarantee and Liability

© 2021 GAMMA Medizinisch-wissenschaftliche Fortbildungs-GmbH

This document contains information protected by copyright. All rights reserved. This document may not be duplicated, repro-

duced or translated into other languages, fully or partially, w ithout the express w ritten permission of GAMMA Medizinisch-

w issenschaftliche Fortbildungs-GmbH.

®, ™ Trademarks and Brands:

Axiograph and SAM are registered trademarks of the company SAM Präzisionstechnik GmbH, Germany. Microsoft and Win-

dow s are trademarks of the company Microsoft Corporation, USA. Artex is trademark of the company Amann Girrbach

GmbH, Germany. Denar, Hanau and Whip Mix are trademarks of the company Whip Mix Corporation, USA. KaVo is trademark

of the company KaVo Kaltenbach & Voith GmbH & Co, Germany. Panadent is trademark of the company Panadent, USA.

GAMMA, GAMMA Dental Softw are, CADIAX and CADIAS are trademarks of the company GAMMA Medizinisch-w issenschaft-

liche Fortbildungs-GmbH, Austria. Stratos is trademark of the company Ivoclar Vivadent AG, Liechtenstein.

All of the products and product names mentioned in this handbook are brand names of the respective companies. The ab-

sence of the symbols ® or ™ does not imply that the name is an unprotected brand name.
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1 Introduction
Thank you for showing your confidence in us by purchasing the CADIAX system. You have purchased a
top-quality medical device, designed based on more than 25 years of experience in the electronic con-
dylography registration.

In the following pages, we would like to help you get acquainted with the CADIAX device and its soft-
ware.

1.1 Explanation of used symbols on packaging and device

The following symbols are used on the product and/or within the operating instructions:

Attention: See accompanying instructions

Attention: Magnetic field

Follow operating instructions
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Manufacturer

Manufacturing date

Serial number

Upper and lower limit for temperature

Upper and lower limit for relative humidity

Upper and lower limit for atmospheric pressure

Do not sit on the device

Do not step on the device

Type B applied part

Dispose separately from other waste material

Direct Current (DC)
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Universal Serial Bus (USB)

Foot switch

or Measuring sensors of the right patient side

or Measuring sensors of the left patient side

1.2 Important safety considerations

For your own safety, as well as for operational safety, please read these instructions thor-
oughly, before beginning to operate the device. Always comply with any and all warnings
included in these instructions, and/or on the device itself.

1.2.1 General safety instructions
The device must be operated in a roomy area, in order to allow for proper dissipation of
heat.

Never operate the device in areas where there is a danger of water or other liquids seep-
ing into the device.

The device is powered by the computer it is connected to, through the Universal Serial
Bus (USB). Only connect the device directly to a computer's USB terminal. Never operate
the device through a USB hub and never use alternative power sources of any kind.

Never set up the system in the proximity of potential fields of electromagnetic interference
(loudspeakers, mobile phones, sterilizers, etc.).
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Never attempt to repair the device yourself. All repair work must be done by authorized,
trained technicians.

In the following cases disconnect the device from the computer and contact a qualified
service technician:

· If water or other liquid seeps into the device.

· If the device does not operate properly, although the operating instructions have been
followed correctly.

· If the device has fallen down or if the housing is damaged.

· If the device shows noticeable deviation from its normal operation.

Please make sure that the device is set up on a smooth, even surface, which is longer
and wider than the device itself.

The surface on which the device stands must be sufficiently stable, as the device could
be badly damaged by shaking or falling.

In choosing the working area and/or storage area, make sure that the device is not sub-
ject to extreme deviations in temperature or humidity, as well as to direct sunlight and ex-
cessive heat.

Make sure that the device is not subjected to vibrations and jolts.

Also make sure that the cable does not pose a hindrance (tripping hazard).

Do not sit on the device since this may cause it to be severely damaged.

Do not step on the device since this may cause it to be severely damaged.
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1.2.2 Special information about medical electrical devices

1.2.2.1 Setting up the CADIAX device

If the computer connected with the
CADIAX device is in the proximity of the
patient, it must have been tested in com-
pliance with standard EN 60601-1.

The patient proximity (definition according
to standard EN 60601-1) is the area
within which the patient could, intention-
ally or unintentionally, come into contact
with:

· either any parts of the medical elec-
trical device/system, or

· with someone using or touching a part
of the device/system.

Definition of patient proximity, according to standard EN

60601-1

If the computer connected with the CADIAX device is not built according to standard EN 60601-1, it
must be set up outside the proximity of the patient.

If such a computer is set up inside the patient's proximity, it and all devices connected to it (e.g. mon-
itor) have to be isolated according to EN 60601-1. Power sources have to be connected through a med-
ical isolation transformer and tethered network connections through a medical network isolator.
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Avoid using the CADIAX device directly next to other devices or stacked on top of other
devices, as this could lead to faulty operation. If, however, it is necessary to use the
device in the manner stated, the CADIAX device as well as the other devices must be
monitored to ensure they are working properly.

1.2.2.2 Operating the CADIAX device

Only switch the device into recording mode after the measuring sensors (flags and styli)
are completely mounted.

Make sure that the sensors are not touched during the registration, not by yourself nor by
the patient.

Always switch off the recording mode before detaching the flags and styli from the face
bow.

1.2.2.3 Features of the CADIAX 4 device enclosure (diagnostic sensor set)

When using the "diagnostic" sensor set, the enclosure of the CADIAX 4 main unit has the following fea-
tures:

Front side

1 Connector socket for the measuring stylus of the right patient side

2 Connector socket for the measuring flag of the right patient side

3 LED for indication of the current device status (refer to chapter "Status in-
dication of the CADIAX device ")

4 Connector socket for the measuring flag of the left patient side

5 Connector socket for the measuring stylus of the left patient side

15
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Back side

6 Connector socket for the foot switch

7 Type label with information regarding the manufacturer and the device

8 USB 2.0 (type B) connector socket for the cable connection to the PC

1.2.2.4 Status indication of the CADIAX device

The CADIAX device indicates its operating state via a green LED on the front side of the enclosure. This
LED can be in the following conditions:

LED is permanently on:

Device is connected to a PC and is ready for
operation.

LED flashes with 5 Hz:

A measurement is in progress.

LED flashes with 0.5 Hz:

An internal hardware error occurred in the
device. No measurement is possible.

LED permanently off:

The device is not connected to a PC and is
turned off.

1.2.2.5 Electromagnetic compatibility

Medical electrical devices require special safety precautions with regard to electromag-
netic tolerance. Therefore, the CADIAX device may only be installed and put into opera-
tion according to the instructions contained in this manual. Failure to comply with the in-
structions herein can potentially impair the measurement accuracy stated in chapter
"Technical data ".57
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Only use accessories which are explicitly approved for CADIAX devices. Using other ac-
cessories, especially cables which are longer than the cable lengths prescribed below,
can lead to increased emission of interferences, or to reduced interference immunity of
the CADIAX device, which may lead to faulty operation.

The following accessories to the CADIAX system affect the system's electromagnetic compatibility and
may be replaced by the user. Components not listed here may only be replaced by the manufacturer.

Accessory Maximum cable length

Foot switch 3.0 m

USB cable (USB 2.0, type A plug to type B plug, shielded) 3.0 m

CADIAX "compact" sensors 1.5 m

CADIAX "diagnostic" stylus (only applicable to CADIAX 4 devices) 1.5 m

CADIAX "diagnostic" flag (only applicable to CADIAX 4 devices) 1.5 m

Portable and mobile HF-communication appliances, e.g., mobile telephones, cordless
telephones, computers, and laptops with activated WiFi, etc., can have detrimental ef-
fects on medical electrical devices. Do not operate the CADIAX device in the proximity of
these potential sources of interference, and make sure to adhere to a safe distance of at
least 30 cm. Non-compliance can lead to reduced performance of the device.

1.2.2.6 Connecting other devices

Devices connected to analog or digital interfaces must be certified to satisfy the applic-
able standard EN specifications (e.g., EN 60950 for data-processing devices, or EN
60601 for medical electrical devices). In addition, all configurations must satisfy system
standard EN 60601-1. Whoever connects supplementary devices to the signal input or
outlet units is the system configurator and therefore responsible for ensuring that system
standard EN 60601-1 is adhered to.

1.2.3 Contraindications - Limitations to application
When operating the CADIAX system, the following conditions can hinder or limit its ap-
plication:

· Cognitive abilities: Patients who are not able to follow or carry out the attending dent-
ist's instructions correctly (e.g., where to move the lower jaw, etc.), for physical or psy-
chological reasons.

· General clinical symptoms: Patients with illnesses that do not allow for the attach-
ment of a face bow for registration purposes. Illnesses may be physical or psycholo-
gical in nature (e.g., spastic, epilepsy, claustrophobia, injury or disease of the skull or
soft-tissue structures of the skull, ears, etc.).

· Dental clinical symptoms: Patients with odontopathy or periodontal disease, which
excludes the mounting of a clutch (parodontosis, loose teeth, damage to the tooth sub-
stance, changes in the mucous membranes in the mouth or pharynx, etc.).
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· Certain diseases in the ear region: Patients with diseases in the ear region which
exclude the fixation of the face bow in the auditory canal (e.g., painful inflammations,
tinnitus, ear pain, etc.).

· Muscle pain in the head and neck region: Patients with extreme muscle pain in the
head and neck region that are not able to wear the face bow for the duration of the ex-
amination.

· Patients between 0 and 9 years of age: Experience has shown that children are first
able to follow the dentist's instructions well enough to lead to a successful examination
from about 10 years of age onwards. In addition, existent deciduous teeth can make it
difficult to fix the clutch.

· Wearers of implants: Patients with active implants (e.g., cardiac pacemakers) should
be handled cautiously when using the CADIAX magnet-sensor system, as the stylus
tip, to which a magnet is attached, could come into proximity of such implants.

1.2.4 Magnet sensor system

The CADIAX Magnet-Sensor system ("M"-Sensor) contains a magnet in the tip of the
stylus. For this reason, special care is necessary when using it with patients with cardiac
pacemakers or implanted defibrillators. Make absolutely sure to adhere to the necessary
safe distances! If necessary, consult the responsible cardiologist. If in doubt, refrain from
using the CADIAX "M" Sensor system.

1.3 Intended purpose

The CADIAX system is designed for registration and display of hinge axis movements of the human
mandible, conversion of these movements to the intercondylar distance of an articulator, and calculating
the settings for this articulator, appropriate to the patient.

The system is used by dentists and dental technicians.

1.4 About this manual

The authors of this user manual assume that the reader has a basic knowledge of condylography, work-
ing with a face bow, and the transfer of its head-related data into an articulator.

In addition, a sound basis in the Microsoft Windows operational system is required. The user should be
able to work with the user-interfaces and other operational elements of the Windows programs.

This handbook is not a substitute for a basic education in using the Windows operating system. If you
have only little or no education in Windows, we recommend that you first become acquainted with the
system. This will make it much easier to work with the CADIAX software.

1.5 Symbols and notations

Special attention will be brought to important aspects using the following symbols:

Warning Possible sources of error, or the danger of a possible operational error.
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Attention Especially important information regarding the topic being described.

Information Useful tips and tricks.

The following symbols and notations will be used in this user manual to describe certain commands and
instructions for operating the software:

· Designations of keys will be written in italic font style. For combinations of keys, the individual key
specifiers will be concatenated with plus signs (+). For example, Ctrl+D means: Hold down the Ctrl
key on your keyboard and simultaneously press the D key.

· Names of menu items in the software will be written in italic font style. If several menu items need to
be selected in succession, they will be concatenated with arrows. For example, File  Close means:
First, click on the File menu item in the menu bar, then click on the menu item Close in the opened
menu.

The first occurrence of Special Terms that may be used in subsequent descriptions are highlighted in
bold and italic font style.

1.6 User interface terminology

All GAMMA software applications use a user interface layout consisting of the following parts:

· The Working Area is the area of the application that
displays the actual patient data and will therefore re-
ceive the highest amount of attention and interaction.

· The hierarchical menu structure of the Menu Bar at
the upper border of the window provides access to
many of the application's functionalities. Most general
application settings that are independent of the actual
patient data can be configured here.
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· The Tool Bar that is located below the menu bar
provides icons to quickly access commonly used
functionalities. The availability of these icons can de-
pend on the actual state and working context of the
application. 

· The Status Bar at the lower border of the window dis-
plays contextual information regarding the actual state
of the application as well as progress information in
the case of long-running tasks.

1.7 Scope of delivery

The accompanying packing list describes the exact scope of delivery. After taking delivery of
your CADIAX system, please make sure to immediately check the package contents for com-
pleteness and faultless condition.

The CADIAX system does not include the material for fixing the occlusal-tray clutch on the lower jaw
teeth of the patient. You will need suitable bite registration material (e.g. Exabite II by GC) and the ap-
propriate dispenser.

For fixing the para-occlusal clutch, you will need a composite for temporary restorations (e.g. Protemp II
by 3M) and a temporary cement such as a zinc-oxide cement (e.g. TempBond by Kerr) or a carboxylate
cement (e.g. Durelon by 3M).

Furthermore, a face-bow system is required for mounting the CADIAX measuring sensors, such as Con-
dylograph or Condylograph comfort by GAMMA. Such is not included in the regular scope of delivery of
the CADIAX system.

Please contact your local distributor for further information.
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1.8 System requirements

A computer is required in order to use the CADIAX system. GAMMA Dental Software in version 7.8 or
higher needs to be installed on the computer. The software is not included in the regular scope of deliv-
ery of the CADIAX system.

Please refer to the manual of GAMMA Dental Software for the requirements regarding the com-
puter system.
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2 Preparing to operate the CADIAX device
Before beginning to work with the CADIAX system, several preparatory steps must be carried out.

2.1 Installing the software

Install the software before connecting the CADIAX device to your computer for the first time. This
will install the necessary drivers to let your operating system to recognize the device.

Refer to the manual of GAMMA Dental Software for the installation of the software.

2.2 Starting and activating the software

The procedure of starting and activating the software is described in the manual of GAMMA
Dental Software.

Following a successful activation, the recorder applica-
tion CADIAX Recorder can be started from GDSW clas-
sic or GAMMA Document Browser and stores the recor-
ded data in the respective database.

2.3 Setting the face bow

Set the type of the face bow that you use in the menu
Options  CADIAX Unit Settings:
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The various face bows have different scales for entering face geometries. If a wrong face bow is
selected or a wrong scale value is entered, the recordings can not be recalculated correctly.
This can lead to a distorted picture of the recorded condylar tracks and, in some circum-
stances, to a falsification of the calculated value settings for the articulator.

The face bow Condylograph comfort may be used with either of the following reference point indicators.

The fixed reference point indicators P (Patient) and T (Trans-

fer).

The individual reference point indicator.

The fixed reference point indicators are mounted at a height of 22 mm, which cannot be adjus-
ted. If the anatomical situation of the patient requires a different height, the individual reference
point indicator should be used.

2.4 Hardware test

The pane Hardware Test of the CADIAX Recorder soft-
ware allows checking the hardware condition of the sys-
tem.

The display indicates errors in the system by highlight-
ing the affected component in the graphic and shows an
error description in the area Diagnostics.
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3 Recording TMJ movement
In principle, the registration of mandibular movement is always carried out in the following steps:

1. Preparations

2. Fixing the clutch onto the teeth of the lower jaw

3. Mounting the upper face bow

a. Condylograph

b. Condylograph comfort  

4. Mounting the writing bow

5. Locating the hinge axis

6. Attaching the measurement flags and styli

7. Recording the joint track curves

8. Registration of CPM  (if a para-occlusal clutch is used)

9. Finishing the registration, saving data

3.1 Posture of the patient

The patient should sit in an upright and relaxed position. Body movements during condylography record-
ing can change the hinge axis position and should be avoided. The head should be held upright and the
upper spine in the habitual normal position, i.e. not be bended forward or backward. It is recommended
to use a head and neck support.

Glasses, earrings, hair barrettes, etc. of the patient should be taken off. Electrostatically charged hair
can cause artifacts in the recordings. This effect is intensified by hairspray. For this reason, the patient
should wear a cap, e.g. a surgical cap as used by surgeons. Long hair should be combed back behind
the ears.

3.2 Instructing the patient

Explain the lower jaw movements like protrusion, retrusion, mediotrusion and medioretrusion to the pa-
tient. Ask the patient to execute all these movements completely and as far as possible. Practice these
movements before mounting the face bow.

3.3 Preparations

Before starting the registration, prepare all necessary devices and materials.

Connect the CADIAX device to your computer and start the recording software. If the device has been
detected, this will be indicated in the status bar of the software. If this is not the case, you can find in-
formation for error correction in the chapter "Troubleshooting ".
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3.3.1 Fixing the clutch onto the lower jaw teeth
There are two different kinds of clutches available for attaching the lower face bow to the lower jaw.
These are:

The occlusal-covering tray clutch. The para-occlusal clutch.

In the case of edentulous patients, the clutch can also be attached to the lower jaw using a mandibular
clamp.

The occlusal-covering tray clutch and the functional occlusal clutch are shipped in non-sterile
condition and must be disinfected and/or sterilized before use. For the hygienic instructions re-
garding cleaning and reuse, please refer to chapters "Functional occlusal clutch " and "Oc-
clusal tray clutch ", respectively.

Examine the periodontal status of the lower jaw dentition. In case of a poor periodontal situation,
either refrain from using the clutch, or, at the attending dentist's responsibility, take suitable pre-
cautionary measures (e.g., blocking out). Areas of the dentition, undercut to the occlusal plane,
should always be blocked out with appropriate material (e.g., soft wax), even with patients that
have a healthy periodontal status.

If you fix the clutch to a provisionally cemented denture, the possibility arises that the denture
can become loose due to mechanical influences. In such cases, you must determine whether
provisional cementing is appropriate or not.

Check whether the clamp on the writing bow can be pushed onto the clutch shaft easily. If this
is not the case, do not continue using that particular clutch.

3.3.1.1 Fixing the occlusal tray clutch

If you are using a para-occlusal clutch, you may skip this section.

The occlusal tray clutch is available in multiple sizes.
Select a clutch of an appropriate size for the patient.

58

58
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Before introducing the silicone material, inlay the clutch with 3 thin rolls of soft wax (diameter 3-
4 mm). The rolls are attached at diagonals to the arch, one in the front and two in the back.
They provide predetermined breaking points, which will make removing the clutch much easier.

Use exclusively a silicone adhesive (bite registration material), with a Shore-hardness of max-
imum A60. Follow the manufacturer's instructions!

Fill the clutch to maximum 2/3 with the silicone material.

Place the filled clutch onto the lower jaw teeth and set
the shaft in a median-sagittal position. The patient draws
back the lower jaw and closes, thus automatically posi-
tioning the shaft so that the smallest possible locked
bite is achieved.

Before mounting the lower face bow, the silicone must be completely set, with the patient's
mouth slightly open. Follow the manufacturer's instructions! It is advisable to leave a separate
material sample extra-orally with which you can check the hardening process. Make sure that
no interferences occur in the back areas, caused by material being squeezed out.

3.3.1.2 Fixing the para-occlusal clutch

If you are using an occlusal tray clutch, you may skip this section.

When using a functional occlusal clutch, you can analyze the effects of occlusion on the TMJ position
and hinge axis movement. Condyle position measurements (CPM) can be carried out directly in the pa-
tient's mouth, so you no longer need to measure CPM on mounted casts. The functional occlusal clutch
is located outside of the occlusion, so it doesn't touch the upper jaw teeth, neither in intercuspation, nor
in function.
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For fixing the para-occlusal clutch you will need a com-
posite for temporary restorations (e.g. Protemp II by 3M
ESPE).

Additionally, you will need a temporary cement such as
a zinc oxide cement (e.g. TempBond by Kerr) or a
carboxylate cement (e.g. Durelon by 3M ESPE).

 

Place the clutch in the patient's mouth and bend the
wings to fit on the lower tooth arch. Allow 1-2 mm of
space between the teeth and the clutch, for the plastic.

Place a wax plate between the upper and lower teeth,
and have the patient bite down. The wax plate prevents
the plastic from flowing onto the upper teeth, and elimin-
ates the tiresome job of having to polish the clutch's
plastic surface.

Prepare the composite according to the manufacturer's
information.
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Coat the surface of the clutch, which should be facing
the labial and buccal teeth, with a 2 mm thick layer of
plastic. Wait until the material begins to set.

Place the clutch in the patient's mouth and instruct the
patient to close, without allowing the upper teeth to
touch the clutch (check this).

The clutch shaft should lie in the median sagittal plane.

Wait until the material has set, then remove the clutch
from the patient's mouth.

Remove any excess interferences of the plastic material
with a sharp knife or a cutter.

Use as little plastic as possible. Too much plastic often causes pain in the gums.
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Check to see whether the clutch fits properly in the
mouth.

Occlusion paper marks the contacts between the clutch and upper jaw teeth, which have to be
removed.

If the plastic has not completely set yet, you can lay the clutch aside and begin mounting the
upper face bow.

Prepare the cement according to the manufacturer's in-
formation.

Fix the clutch with the cement on the lower jaw teeth.

Do not fix the para-occlusal clutch onto painful or loose teeth.

After the registration, the clutch can be removed easily. The teeth will only need a light cleaning (scal-
ing). The same plastic-coated clutch can be re-used for the same patient (residues on the clutch do not
necessarily need to be removed).
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3.4 Mounting the kinematic facebow

3.4.1 Condylograph

3.4.1.1 Preparing the upper face bow

Before mounting the Condylograph on the patient, the
forehead bracings of the upper face bow need to be
pulled back.

Slightly loosen the side arm clamp screws, so that the
side arms are movable in sagittal (upper clamp screw)
and transversal (lower clamp screw) direction.

Loosen and remove the orbital pointer.

The upper face bow is now ready to be mounted.

3.4.1.2 Mounting the upper face bow

Adjust the width of the face bow in a way, that the side
arms are in contact with the skull above the ears evenly
without tension. The face bow should be adjusted sym-
metrically.

Put the face bow on the patient's head, whereby the gla-
bella support is placed on the glabella and the side arms
rest above the ears.
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Lower the forehead supports until they are in skin con-
tact and fixate them. An even support on forehead and
glabella should be achieved, which stabilizes the face
bow and significantly improves the patient's comfort.

The retention straps are placed parallel to the side arms
and fastened. Now, the face bow should hold firmly on
the head without further support.

Assemble the red writing flags with writing paper and fix-
ate them on the face bow.

Adjust the depth of the side arms so that the posterior
edge of the flag covers the tragus.

Pay attention that the side arms lie above the ears. The face bow must not be pulled down-
wards, onto the pinna, or upwards by the retention straps.
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Attach the reference point indicator on the cross bar of
the face bow and adjust it to the orbital.

To indicate the position of the orbital point with a lead
mark in a subsequent x-ray, you can now mark the point
on the skin.

Afterwards, fixate the reference point indicator and re-
move it from the face bow.

3.4.2 Condylograph comfort

3.4.2.1 Preparing the upper face bow

Slightly loosen the side arm clamp screws, so that the
side arms are movable in sagittal (upper clamp screw)
and transversal (lower clamp screw) direction.

Loosen and remove the orbital pointer.

Fixate the glabella support by pushing it from the side
into the center position until it snaps in.
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The actual nose support can easily be exchanged. It is
only put on the glabella bridge.

The upper face bow is now ready to be mounted.

3.4.2.2 Mounting the upper face bow

Adjust the width of the face bow in a way, that the side
arms are in contact with the skull above the ears evenly
without tension. The face bow should be adjusted sym-
metrically.

Put the face bow on the patient's head, whereby the gla-
bella support is placed on the glabella and the side arms
rest above the ears.

The retention straps are placed parallel to the side arms
and fastened. Now, the face bow should hold firmly on
the head without further support.
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Assemble the red writing flags with writing paper and fix-
ate them on the face bow.

Adjust the depth of the side arms so that the posterior
edge of the flag covers the tragus.

Pay attention that the side arms lie above the ears. The face bow must not be pulled down-
wards, on the pinna, or upwards by the restraining band.

Attach the reference point indicator on the cross bar of
the face bow and adjust it to the orbital.
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To indicate the position of the orbital point with a lead
mark in a subsequent x-ray, you can now mark the point
on the skin.

Afterwards, fixate the reference point indicator and re-
move it from the face bow.

3.4.3 Preparing the lower face bow

Move the side arms of the lower face bow into their cen-
ter position.

Slightly loosen the screws, so that the side arms and the
double clamp on the crossbar are movable.

Adjust the two axis needles so that they protrude 2 cm
from the axis pin jack.

The writing bow is now ready to be mounted.
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3.4.4 Mounting the lower face bow
The side arms of the lower face bow are pushed com-
pletely outwards, then slightly fixated. The patient holds
the lower jaw closed and in centric (retral) position. The
double clamp is pushed onto the clutch.

Make sure not to loosen the clutch and check once more
that it fits correctly.

Adjust the writing bow so that it is parallel to the upper
face bow.

Tighten the clamp on the lower cross bar. In doing so,
support the lower face bow with your second hand to
avoid too much force being transferred to the clutch.
Strong force can cause pain or loosen the clutch.

Insert the axis needles into the retainers at the end of the
side arms and adjust their location to the approximate
position of the joint axis.

Finally, tighten the screws to fasten the clamps at the
lower ends of the side arms to the cross bar.

3.4.5 Determining the joint axis

Push the axis needles in until they are in contact with
the writing flag. Fixate the needles in this position.
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Start in retral joint position and guide the lower jaw of the
patient with the chin in retral open-close movements.

Adjust the setscrews of the side arm in a way that the
axis needle solely rotates without drawing a translatory
movement on the flag.

3.4.6 Attaching the sensors

Only touch the flags on their borders. Avoid touching the black measuring surface to prevent it
from being soiled or scratched. Also make sure that recording mode is turned off while you
mount the flags and styli.

Fixate the flags on the designated sockets of the upper
face bow. Avoid jamming anything between the side arms
and the flags in this process.

The double-stylus system allows for a recording of the
hinge axis rotation on both sides.

Insert the stylus pin with the larger case completely into
the hole of the side arm. The second pin should be posi-
tion above the first one. Tighten the screw at the end of
the side arm to fixate the stylus.

If the system is mounted properly and the lower jaw is in
centric position, the stylus tip should be located in the
area of the upper back quarter of the flag.
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The styli should be positioned in a way that their axis protrude by about 1 cm to the outside.
This range of movement is, among other things, required for mediotrusive movements.

Avoid touching the measuring surface of the flags and the stylus pins during the measurement
procedure and preparatory work. This also applies to the patient.

3.5 Setting up the CADIAX system

Plug the connector of the foot switch into the designated
jack at the backside of the device.

Connect the device to a free USB-port of your PC.

Subsequently, connect the sensors to the device accord-
ing to the labeling on the casing.

3.6 Software-assisted axis localization

The hinge axis is a functional axis around which the mandible rotates during open/close movements.
The closed, retral position of the mandible is the reference position (RP), which is the starting point for
localizing the hinge axis.

Before starting the actual recording, the recording software allows exact determination of the hinge axis
position and adjusting the stylus appropriately. For the localization, the software uses the translatory
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curves that the styli draw on the flags when they are not positioned exactly in the center of rotation (i.e.
on the hinge axis).

The software provides both single and dynamic axis localization methods. The latter method is recom-
mended because it averages multiple measurements, resulting in a more accurate hinge axis localiza-
tion.

If you prefer to determine the hinge axis position mechanically or by using another method, you
can skip the axis localization functionality and continue with setting the reference position.

The axis localization procedure can be repeated any number of times. It should always be car-
ried out at least one more time after the stylus position has been adjusted.

A correct hinge axis localization might be impossible in cases of severe muscular dysfunction
or TMJ issues. In such cases, a manual localization, as performed during a mechanical condy-
lography, is acceptable.

3.6.1 Single axis localization

During single axis localization, the system takes two
measurements; one with the patient's mouth being open
and one with it being closed. From these two measure-
ments, the software is able to calculate the point around
which the styli were rotated and therefore the location of
the axis.

1. Explain the procedure to the patient.

2. Guide the lower jaw of the patient into the reference position. Try to avoid tooth contact so that
you can position the lower jaw in joint relation without occlusal interference.

3. Press the foot switch to measure the first position. This will initiate a countdown for the meas-
urement of the second position, indicated by a progress bar in the appearing dialog window.

4. Ask the patient to open their mouth about 15 mm. Make sure that the jaw remains in a retral po-
sition and does not carry out any translatory movements. Wait for the system to take the
second measurement.

5. Let the patient move into reference position and continue with adjusting the styli to the determ-
ined axis location (refer to chapter "Axis fixup ").

It is often easier to let the patient open their mouth for the first measurement and then move into
a retral, centric position. Since that position is also used for fixing the axis, an additional source
of error can be avoided.

40
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3.6.2 Dynamic axis localization
Compared to single axis localization, dynamic axis loc-
alization uses continuous open/close movements for de-
termination of the joint axis. Multiple measurements are
taken and averaged for a more precise result, even with
only minor movements.

If the "Rotate Stylus" symbol appears during the axis localization, it indicates that a stylus is in
an inappropriate position in relation to the rotation axis of the mandible. You can resolve this by
rotating the stylus of the respective side in its retainer.

If the "No Contact" symbol appears during the axis location, it indicates that a stylus has lost
contact with the flag surface. If all cables are connected correctly and the stylus is within the
sensitive area of the flag, please inspect the flag surface and clean it if necessary.

1. Explain the procedure to the patient.

2. Guide the lower jaw of the patient into the reference position. Try to avoid tooth contact so that
you can position the lower jaw in joint relation without occlusal interference.

3. Press the foot switch to start the measurements.

4. Guide the patient's lower jaw in repeated
open/close movements. Make sure that the jaw
remains in a retral position and does not carry out
any translatory movements. The software will dis-
play the calculated axis points and the number of
measurements taken in real-time.

5. After enough measurements have been per-
formed, the software will indicate this by display-
ing the calculated axis point in green color on
both sides. As soon as that is the case, you can
press the foot switch again to stop the measure-
ments.
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6. Let the patient move into reference position and continue with adjusting the styli to the determ-
ined axis location (refer to chapter "Axis fixup ").

The color of the calculated axis point provides information about the number of individual meas-
urements. With up to five measurements, it will be red, with up to ten measurements, it will be
blue, and from ten measurements on, it will be green.

You can find advanced options for the calculation of the axis points in the menu Options Axis
Location Parameters.

3.6.3 Axis fixup

When the axis points have been localized, the styli need
to be adjusted to these positions. During the axis fixup,
the calculated axis points are displayed as white circles
and the actual stylus positions as red crosses.

1. Make sure that the patient is in reference position and stays in that position during the axis
fixup.

2. Adjust the inclination and length of the lower
bow's side arms so that the red crosses are
within the white circles.

3. As soon as the styli are positioned close enough to the axis points, you can press the foot
switch to continue with setting the reference position and entering the face bow parameters.

During axis fixup, the distance between stylus position and axis point is displayed at the lower
border of the window in mm. As soon as this distance falls below a certain threshold, the view
will be enlarged automatically to allow more accurate adjustments.

For verifying the reproducibility of your method or the joints, you can repeat an axis location fol-
lowed by an axis fixup any number of times.

You can mark positions, show movement tracks and change zoom settings via the View menu.

40
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3.7 Setting the reference position

Guide the patient into the retral reference position and
press the foot switch. The position set here will be used
as zero point for the following recordings.

You can also re-set the reference position between recordings via the "refix" functionality or by
switching to this tab.

3.8 Face bow parameter input

In order to recalculate the recordings according to the mounting of the upper face bow, it is necessary to
enter the face bow parameters.

Refer to chapter "Setting the face bow " for instructions regarding the selection of the used
face bow.

Note that the terms "left" and "right" always refer to the corresponding side from the patient's
point of view. All values have to be entered in millimeters.

3.8.1 Condylograph
The following parameters have to be entered when using
the Condylograph face bow.

Y-Shift is the shift of either side arm of the upper bow to left or right side. It can be read from the scales
on the front of the face bow's cross bar. Values that are located towards the inner side, relative to the
zero point of the scale, are entered as negative values.

X-Shift is the shift of either side arm of the upper bow in anterior or posterior direction. It can be read
from the scale on the respective side arm. Values that are located towards posterior, relative to the zero

21
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point of the scale, are entered as negative values.

The anterior face bow height is the difference in height between the marked orbital point and the upper
face bow. The value can be read from the vertical scale of the reference point indicator.

The anterior face bow depth is the difference in depth between the marked orbital point and the upper
face bow. The value can be read from the horizontal scale of the reference point indicator.

3.8.2 Condylograph comfort

The following parameters have to be entered when using
the Condylograph comfort face bow.

Y-Shift is the shift of either side arm of the upper bow to left or right side. It can be read from the scales
on the top side of the face bow's cross bar.

X-Shift is the shift of either side arm of the upper bow in anterior or posterior direction. It can be read
from the scale on the respective side arm.

The anterior face bow height is the difference in height between the marked orbital point and the upper
face bow. The value can be read from the vertical scale of the reference point indicator.

When using the fixed reference point indicators, the value cannot be changed and is fixed to their
mounting height of 22 mm.

The anterior face bow depth is the difference in depth between the marked orbital point and the upper
face bow. The value can be read from the horizontal scale of the reference point indicator.

When using the individual reference point indicator, it is additionally required to specify the position, in
which this value is measured. In position T (transfer), the pointer is oriented parallel to the side arms of
the face bow, and in position P (patient), it is inclined by 30° towards the patient's nose.
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3.9 Recording joint movements

3.9.1 Joint track curves
After setting the reference position and entering the face
bow parameters, you can start with the actual recording
of condylography curves. To do so, change to the Re-
cording tab.

If you frequently use the same sequence of recordings, you can create a reusable macro for this
purpose. See chapter "Using recording macros " for further information.

CADIAX Recorder allows an unlimited number of record-
ings to be performed. To create a new curve recording,
select the menu point New Curve in the Data menu or
the corresponding button in the toolbar. The dialog for
specifying the parameters of the recording will appear.

Type in this dialog refers to the name of the curve that will be passed on to the analysis applications
and remains editable in those.

Time specifies how long the movements of the patient will be recorded. A duration of 4.5 seconds
turned out to be reasonable for this purpose. For movements that take more time (chewing, speech,
etc.), it is possible to increase the duration accordingly.

Before starting a recording, ensure that the patient is in reference position. In the ideal case, the
red cross of the real-time cursor is positioned exactly in the origin of the coordinate system. If
this position is difficult to reproduce, you can re-set the software's reference position via the tab
of the same name (refer to chapter "Setting the reference position ").

The provided system- and user-defined recording types can be configured via the menu Edit 
Definitions. Instead of selecting a provided type, you can also enter a custom name for the re-
cording.

47
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After having confirmed the recording parameters by
clicking OK, you can start the recording by pressing the
foot switch. Subsequently, have the patient carry out the
selected movement.

The start and the end of the recording are signaled
acoustically. During the recording, the progress will be
displayed and the curve will be drawn in real-time.

Once the recording is finished, it will be displayed in the
recording window and you can proceed with the next
one.

You can use the menu item Data  Delete or the corresponding toolbar button to remove an already
performed recording.

Check a curve for its quality immediately after the recording. To do so, check the starting point
of the movement track relative to the reference position (i.e. the origin of the coordinate system),
as well as smoothness of the curve line. Ideally, the movement starts exactly in the zero point
and doesn't show any distortion artifacts of any kind.

Registrations with obvious distortions should not be accepted. In such cases, clean the flags
and styli thoroughly and repeat the recording. If this doesn't prevent artifacts from appearing,
cancel the registration and contact an authorized GAMMA service center.

In addition, movement tracks that differ from the expected shape should be treated skeptically
and have to be verified with further registrations.

Please note that the designations mediotrusion right and mediotrusion left always refer to the
condyle of the patient that is carrying out the mediotrusive movement. Mediotrusion right there-
fore means a mandibular (i.e., of the chin) movement to the left side and vice versa.
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To overlay a curve with one another, you can have the former permanently displayed in the back-
ground by using the menu item Data Selected As Reference Curve, the corresponding tool-
bar button, or by simply double-clicking the item in the list.

3.9.2 Condyle position measurement (CPM)

A condyle position measurement (CPM) describes the measurement of the 3-dimensional offset in the
joint between a reference position and any another joint position (e.g. maximum intercuspation ICP). For
CPM, the first measurement of the recording will be the reference to the following ones.

Naturally, measurements of a position relative to the occlusion (e.g. ICP) only make sense if the
registration clutch is fixed to the lower jaw teeth in para-occlusal method.

To create a new CPM recording, select the menu point
New CPM in the Data menu, or the corresponding button
in the toolbar. The dialog for specifying the parameters of
the CPM recording will appear.

Similar to the curve recording parameters, Type is the name assigned to the CPM. A recording of type
Point Mode can hold an unlimited number of individual point measurements, which are taken by press-
ing the foot switch repeatedly.

For CPM, Time refers to the amount of time between the first and the second measurement. Impulse
stands for an unspecified amount, where the second measurement will be taken as soon as the foot
switch is pressed again.

The provided system- and user-defined recording types can be configured via the menu Edit 
Definitions. Instead of selecting a provided type, you can also enter a custom name for the re-
cording.

The predefined acronyms stand for:

RP: Reference Position

RCP: Retral Contact Position

ICP: Intercuspation

RES: Resilience of the mandibular joint

ETP: Expected Therapeutic Position

IVP: Ideal Vertical Position

FBP: Forced Bite Position
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After having confirmed the recording parameters by click-
ing OK, you can start the recording by pressing the foot
switch.

The start and the end of the recording are signaled
acoustically. If a time between the two measurements
has been specified, the progress will be displayed during
the recording.

Once the recording is finished, it will be displayed in the
recording window and you can proceed with the next one.

You can use the menu item Data  Delete or the corresponding toolbar button to remove an already
performed recording.

By selecting the CPM points in the coordinate system, you can have the following values displayed on
the lower border of the window:

Delta X The distance between the two measurements along the X axis, i.e. in sagittal direction (+X
= anterior, -X = posterior), for right and left side.

Delta Y The distance between the two measurements along the Y axis, i.e. in transversal direction
(+Y = to the right side, -Y = to the left side).

Delta Z The distance between the two measurements along the Z axis, i.e. in vertical direction (+Z
= downwards, -Z = upwards), for right and left side.

Delta H The difference of the incisal pin height in the articulator.

Delta W The side shift of the incisal pin on the incisal table.
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Delta L The anterior-posterior shift of the incisal pin on the incisal table.

Gamma The amount of hinge axis rotation between the two measurements.

3.9.3 Using recording macros

With recording macros, you can define reusable se-
quences of curve and CPM recordings once and repeat
them during following recording sessions.

The macro editor allows you to create new macros or
edit existing ones. It can be started via the item Edit
Macro File in the Data menu.

Use the provided buttons to add curve or CPM recordings to the sequence or to remove them. You can
change the order of the items in the list by dragging them while holding the left mouse button. Once fin-
ished, save the macro to a file using the corresponding button.

To use a created macro during recording, switch to the Recording tab and select the menu entry Data
 CADIAX® Recorder Macro or the corresponding button in the toolbar.

The option Macro Easy Start in the Options menu allows individual recordings to be started with
only a single press of the foot switch during the execution of a recording macro.

3.10 Finishing the registration

After having performed all required registrations, you can transfer them to GAMMA Dental Software via
the menu item  or via the floppy disk icon in the toolbar.

Make sure to switch off the recording mode before starting to dismantle the system!

To prevent data loss due to issues occurring while saving the recordings, those are saved in the
sub-directory GDSW/Temp of the user's documents folder. To recover such a file with the exten-
sion *.cxc, use the corresponding menu item in the Data menu.

Disassemble the system in reverse mounting order. First, loosen the measuring styli and flags from the
face bow and subsequently remove the lower face bow from the clutch. Afterwards, remove the upper
face bow and eventually remove the clutch.

To loosen the clutch, move its shaft carefully up and down. When removing the clutch, take care
to not have it hit against the teeth of the upper jaw due to jerky movements. If necessary, pro-
tect them, e.g. by putting a wax plate in between the teeth.
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3.11 Real-time display

CADIAX Recorder provides several ways to visualize the stylus movements on the measurement flags in
real-time, without performing a recording.

3.11.1 Flags

The pane Flags displays the physical X/Z positions of
the stylus pins on the flags.

You can mark positions, show movement tracks and change zoom settings via the View menu.

3.11.2 Time curves
The pane Time curves displays the measured coordin-
ate and AUX values over time. The upper display area
represents the right patient side, the lower area the left
one.

You can adjust the display speed and the curves to display via the area on the right border of the win-
dow.

AUX data from external sources can only be processed with CADIAX diagnostic devices.
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3.11.3 3D Animation
The pane 3D Animation visualizes the measured jaw
movements with a virtual representation of the patient's
skull.

The area on the left side of the window provides miscellaneous display options.
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4 Mounting the articulator
The CADIAX system uses the axis-orbital-plane as reference plane for recordings and for transferring the
jaw position into the articulator (refer to chapter "The reference coordinate system "). In the articu-
lator, the plane is described by the right and left hinge axis point and the contact plane of the incisal
table.

This ensures that, when the upper jaw model is transferred into the articulator using the face bow, the
calculated values will match the actual settings of the articulator's condylar housings. For transferring
the model position, a bite fork is attached to the face bow via a freely movable 3D joint support. An im-
pression of the upper jaw teeth is taken and replicated with the plaster models in a transfer stand or dir-
ectly in the articulator.

 

If a different face bow is used for transfer, make sure that the face bow is set to use the same reference
points. Only then is it guaranteed that the values calculated by the CADIAX system match the model
situation in the articulator.

For detailed information regarding the face bow transfer and the mounting of models in the articulator,
please refer to the instruction manual "Reference SL Articulator and Face Bow Systems".

54



Troubleshooting

51

5 Troubleshooting
There are always two steps involved in correcting errors in the CADIAX system: first, determine the prob-
lem and then carry out the recommended solution to eliminate the error.

If errors occur that are not covered in this chapter, contact an authorized GAMMA service center to re-
solve the problem.

The device is not detected by the recording software and the green LED on the front of the device is un-
lit.

Possible cause of error Solution

The device is not connected to the computer. Connect the device with an USB port of your com-
puter.

The USB connection between device and computer
is defective.

Use another USB port or another USB cable.

The CADIAX device is defective. Contact an authorized GAMMA service center.

The device is not detected by the recording software but the green LED on the front of the device is lit.

Possible cause of error Solution

The USB connection between device and computer
is defective.

Use another USB port or another USB cable.

The CADIAX device is defective. Contact an authorized GAMMA service center.

The driver software has not been installed correctly
or has not been installed at all.

Disconnect the CADIAX device from the computer.
Start the setup routine of the software and perform
a repair. Restart the computer and reconnect the
device after a short waiting period. Start the record-
ing software only when the operating system has
finished configuration of the device.

If the computer is connected to the internet, you
can also have the drivers installed by Windows Up-
date automatically.

Other software-related issue. Contact an authorized GAMMA service center.

The green LED on the device front blinks slowly and/or the recording software notifies that a hardware
defect has been encountered.

Possible cause of error Solution

The CADIAX device is defective. Contact an authorized GAMMA service center.

After mounting, the position of the styli is outside the black measuring surface areas of the flags.

Possible cause of error Solution

The patient's lower jaw was not in reference posi-
tion when the writing bow was set to the hinge axis

Repeat the procedure of adjusting the writing bow.
Make sure that the patient keeps their lower jaw
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point. closed in centric position.

The holding clamps of the writing bow are not firmly
tightened.

Make sure that the holding clamps of the bow are
firmly fixated both on the shaft of the clutch and on
the side arms. Otherwise, additional stress caused
by the mounted styli can cause certain displace-
ments.

The writing bow was not properly adjusted to be
free of tension.

Repeat the procedure of adjusting the writing bow.
Make sure to keep the system free of tension. The
writing bow must not be allowed to move, espe-
cially when removing the axis locators.

After mounting, the system indicates that there is no contact between stylus and flag of either side.

Possible cause of error Solution

A stylus is not connected. Plug the stylus into the CADIAX device.

A flag is not connected. Plug the flag into the CADIAX device.

The right and left measuring sensors are erro-
neously interchanged.

Insert the plugs correctly.

A stylus is outside the allowed measuring area of
the flag due to incorrect mounting.

Repeat mounting the face bow. Make sure that
both styli are positioned to stay on the black
measuring surface of the flag, also during medio-
trusive movements.

A measuring flag is soiled. Due to the flag being soiled, there is no continuous
electrical contact between the tip of the stylus and
the measuring surface of the flag. Clean the flag
surface according to the provided cleaning instruc-
tions.

A stylus is defective. Contact an authorized GAMMA service center.

A flag is defective. Contact an authorized GAMMA service center.

The CADIAX device is defective. Contact an authorized GAMMA service center.

Recorded curves go "backwards" instead of protrusive.

Possible cause of error Solution

The right and left measuring sensors are erro-
neously interchanged.

Insert the plugs correctly.

Recorded curves do not begin in the coordinate origin.

Possible cause of error Solution

The position of the styli has changed between set-
ting the reference position and starting the record-
ing.

Repeat setting the reference position. If necessary,
repeat this procedure before each recording.

Recorded curves show strong artifacts.
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Possible cause of error Solution

A measuring flag is soiled. Due to the flag being soiled, there is no continuous
electrical contact between the tip of the stylus and
the measuring surface of the flag. Clean the flag
surface according to the provided cleaning instruc-
tions.

A stylus is outside the allowed measuring area of
the flag due to incorrect mounting.

Repeat mounting the face bow. Make sure that
both styli are positioned to stay on the black
measuring surface of the flag, also during medio-
trusive movements.

"Sliding chair effect" caused by surface friction
between stylus and flag.

The movement of the stylus across the flag surface
can cause a so called "sliding chair effect" to oc-
cur. During such, the tip of the stylus shortly lifts
up from the flag surface, causing electrical contact
to be lost. During application, this effect is often
accompanied by a squeaking sound during move-
ments.

To minimize this effect, apply a smallest possible
amount of medical petroleum jelly onto the measur-
ing surface of the flag. Make sure to clean the flag
after the recording.

A stylus is defective. Contact an authorized GAMMA service center.

A flag is defective. Contact an authorized GAMMA service center.

The CADIAX device is defective. Contact an authorized GAMMA service center.

Recorded curves are too short on one side.

Possible cause of error Solution

A measuring flag is soiled. Due to the flag being soiled, there is no continuous
electrical contact between the tip of the stylus and
the measuring surface of the flag. Clean the flag
surface according to the provided cleaning instruc-
tions.

A stylus is outside the allowed measuring area of
the flag due to incorrect mounting.

Repeat mounting the face bow. Make sure that
both styli are positioned to stay on the black
measuring surface of the flag, also during medio-
trusive movements.

The right or left measuring sensors are not connec-
ted to the device.

Insert the plugs correctly.

A stylus is defective. Contact an authorized GAMMA service center.

A flag is defective. Contact an authorized GAMMA service center.

The CADIAX device is defective. Contact an authorized GAMMA service center.
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6 Background information
In this chapter you will find explanations regarding the terminology and backgrounds of the GAMMA
concept.

6.1 The reference coordinate system

In order to aggregate CADIAX condylography data and CADIAS cephalometry tracings, all GAMMA
products use the hinge-axis-orbital coordinate system as reference. This allows the reproducible and
standardized transfer of recorded data in the analog or virtual articulator.

The basis for the axis-orbital coordinate system is the
axis-orbital-plane (AOP), which is defined by the left and
right hinge axis points and the left orbital point (lowest
point of the orbit's anterior margin). Before a lateral ra-
diography, usually lead markers are placed on these
three points to indicate their location in the x-ray image.

The axis-orbital-plane on the cranium and in the articu-

lator. The visible axis point and the orbital point are

marked red.

The origin of the coordinate system is located centrally
on the hinge axis between right and left condyle. From
this origin, the positive X axis extends anterior towards
the orbital point, the positive Z axis downwards, and the
positive Y axis to the right, from the patient's point of
view. The median-sagittal plane coincides with the X and
Z axis, the transversal plane with the X and Y axis, and
the frontal plane with the Y and Z axis.

The origin of the axis-orbital coordinate system in the

articulator.
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The movements of the right and left condyle recorded
during condylography are visualized in symmetric sub-
coordinate systems with identical axis definitions.

When recording movements on the patient, the distance
between left and right measurement electronics is natur-
ally greater than the distance between the right and left
condylar guidance elements in the articulator. It is for
this reason that recordings have to be recalculated to
the smaller distance before the software can calculate
articulator settings.

The zero points of right and left condyle used w hen re-

cording condylography.

The reference position set during recording represents the zero point of these sub-coordinate
systems. Ideally, the reference position is located on the hinge axis and remains fixed for the
duration of the recording. However, due to physiological reasons, most patients are unable to re-
turn to the precise starting position after a movement. In these cases it can happen that record-
ings do not start in the zero point, unless the reference position has been re-fixed before each
individual recording.

Besides viewing condylographic recordings in sagittal (X/Z) or transversal (X/Y) projection, the CADIAX
applications can also display additional coordinate systems for frontal projection (Y/Z):

The coordinate system w ith sagittal and transversal view . Extended coordinate system w ith sagittal, transversal, and

frontal view .

6.2 Exact and anatomic hinge axis

A CADIAX condylography recording can be carried out based on either the exact or the anatomic hinge
axis of the temporomandibular joint, depending on the used recording system. In both cases, the meas-
urement takes place in close proximity to the joint itself.

The exact hinge axis (also referred to as kinematic or individual hinge axis) is determined during the re-
cording on the patient. Here, the joint is fixated in retral position and the rotation center of stationary
open/close movements is observed. Subsequently, the measurement electronics are adjusted to that
position and the reference position is set. For recording on exact hinge axis without limitations, a
CADIAX 4 or CADIAX diagnostic device is required.

In contrast to the exact hinge axis, the anatomic hinge axis (also referred to as arbitrary hinge axis) is
not ascertained for each individual patient. Rather, its location is given through the empirically determ-
ined distance of 10 mm anterior to the ear canal. This position is indicated on the Reference AB face
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bow that is usually used for anatomic recordings and therefore easy to find and adjust to. Recordings on
the anatomical hinge axis can be carried out with the devices CADIAX compact 2 as well as CADIAX 4.

The advantage of recording on the anatomic hinge axis
is in its simple and quick application. While the devi-
ation from the exact hinge axis inevitably leads to a dis-
tortion of the curve characteristics, its effects on the
movements used for articulator programming, namely
protrusion and mediotrusion, are tolerable.

However, when recording condylography for the purpose
of functional diagnostics and occlusion analysis, the ex-
act determination of the patient's individual hinge axis is
imperative. In this use case, hinge axis deviations of just
a few millimeters in combination with the rotational com-
ponent can cause significantly different movement pat-
terns in the tooth area.

The effects of various deviations from the exact hinge

axis onto the movements of dental cusps.

6.3 Immediate side shift (ISS)

Some articulator systems divide the transversal Bennett curve into an immediate and a subsequent pro-
gressive side shift movement. These two phases of the movement are referred to as "immediate side
shift" (ISS) and "progressive side shift" (PSS), respectively. The separation is made at a particular dis-
tance measured in X direction, which is referred to as "ISS threshold" (ISS-TH).

In the articulator settings calculated by the software, the ISS describes the maximum transversal dis-
placement up to the specified threshold distance. The PSS however is an angle value equatable to the
transversal condylar inclination (TCI), not including the initial displacement.

The ISS threshold (ISS, here: 0.5 mm) separates the Bennett movement in immediate (ISS) and progressive side shift (PSS).
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7 Specifications

7.1 Technical data

ADC resolution: 14 bit (CADIAX compact 2, model A)
16 bit (CADIAX compact 2, model B)
16 bit (CADIAX 4, model A)

Measurement data display: 0.01 mm

Distance accuracy: ± 5 %

Angle accuracy: ± 1.5 °

Supply voltage: 5 V DC (in compliance with USB specifications)

Current input: max. 0.5 A (in compliance with USB specifications)

Protection class: B

7.2 Cleaning

7.2.1 CADIAX device

Make sure that the CADIAX device is disconnected from the computer. Also disconnect the sensors
and the foot switch from the device. Remove dust and dirt with a soft cloth.

Do not use liquid, and make sure that no liquid gets inside the device during cleaning. The
device must never be cleaned under running water or any other liquid. Do not use stiff brushes or
steel wool.

Never clean the device with alcohol, organic solvents, or disinfectants, as these may cause
damage to the components and the housing.

7.2.2 Measuring flags
The flag surface must not be damaged (e.g., scratched) or soiled (oil, dust, fingerprints, etc.). Check the
condition of the flag surface before every application.

If necessary, the flag surface has to be cleaned. To do so, wipe the measuring area with rubbing alcohol
and dapple it dry with a soft, lint-free cloth. Leave it in the open afterwards for it to dry completely. Make
sure not to damage the sensitive surface during cleaning.

Never treat or clean the flags with stiff brushes or other abrasive materials.
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7.2.3 Measuring styli
Only wipe off the styli with a dry, lint-free cloth. If necessary, clean the tips with rubbing alcohol.

Never treat the sockets and the axes with oil or any other lubricants.

7.2.4 Face bow

Parts of the face bow must only be disinfected by spray or wipe disinfection. Wash off any residues un-
der running water. Only the glabella support may be sterilized in an autoclave (5 minutes at 134 °C; 20
minutes at 120 °C).

7.2.5 Functional occlusal clutch
Disinfect the functional occlusal clutch in a disinfecting tank or use disinfectant spray. Subsequently,
clean the registration material off the clutch. Sterilization can be carried out in an autoclave (5 minutes
at 134 °C; 20 Minutes at 120 °C).

7.2.6 Occlusal tray clutch

Disinfect the occlusal tray clutch in a disinfecting tank or use disinfectant spray. Subsequently clean
the registration material off the clutch. Sterilization can be carried out in an autoclave (5 minutes at 134
°C; 20 Minutes at 120 °C).

7.2.7 Bite fork
Disinfect the bite fork in a disinfecting tank or use disinfectant spray. Subsequently clean off any regis-
tration material. If a thermoplastic material has been used, it is advisable to place the bite fork in a refri-
gerator to make removal of the registration material easier. Sterilization can be carried out in an auto-
clave (5 minutes at 134 °C; 20 Minutes at 120 °C).

7.2.8 3D joint support
The 3D joint support must only be disinfected by wipe disinfection.

Never treat the joints of the 3D joint support with oil or any other lubricants and do not place the
part in an immersion bath.

7.3 Recurrent tests

Like all other electronic devices, also the CADIAX device and its electronic components go through the
process of aging. Therefore, the measurement function and security of the device has to be tested at
regular intervals. A test interval of one year is recommended.
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The security testing has to be carried out in compliance with standard IEC 62353 ("Medical electrical
equipment - Recurrent test and test after repair of medical electrical equipment") or the appropriate local
derivative.

During the recurrent tests, any differences in potential between the touchable, conductive elements of
the connector assembly has to be measured. Any detected difference in potential indicates faulty secur-
ity technology, which has to be corrected. These measurements are carried out as supplementary to
the required standard tests above.

Measurement technology testing are carried out by GAMMA or by a service center authorized by
GAMMA.

The measuring flags are subjected to relatively high mechanical stresses, and undergo the results of
normal attrition. They should be replaced after approximately 500 examinations.

7.4 Operating conditions

The device is designed for operation exclusively in dry areas.

· Temperature: From 10 °C to 35 °C.

· Relative humidity: From 10% to 85%, non-condensing.

In case of a drastic change in temperature, wait until the device has reached room temperature before
beginning operation.

7.5 Storage and transport

If the device is to be transported over long distances, pack it in its original packaging. Store the flags
and styli in the appropriate containers as long as they are not in use.

For storage and transport, make sure to comply with the following environmental conditions:

· Temperature: From -10 °C to 60 °C.

· Relative humidity: From 10% to 85%. Store in a dry place!
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· Atmospheric pressure: From 700 hPa to 1060 hPa.

7.6 Disposal

After their product life, the CADIAX device and its components have to be disposed of cor-
rectly. Doing so, comply with the regulations that are in effect in your country or city, re-
garding the disposal of electronic equipment.
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